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MICROSOFT ®  OFFICE L IVE MEETING GUIDE TO 
SHARING CONTENT  

In partnership with Microsoft, InterCall® provides Live Meeting web conferencing services.  This guide makes several 
references to the service name, platform and features. 

 

IMPORTING,  SHARING AND NAVIGATING CONTENT 

Content provides the visual component of the Live Meeting conference for all participants. It’s the basis for allowing 
participants to view, express and share ideas. As a presenter, you can share content in four different ways: 

• Import and display a PowerPoint slide presentation 

• Import and display other document types 

• Display applications that are running on your computer 

• Work with Live Meeting collaborative slides (Whiteboard, Web, Text, Poll and Snapshot) 

Once you have shared content with others in the meeting, you can collaborate in the following ways: 

• Use all the functions of PowerPoint to work with slides in a presentation 

• Mark up other document types using annotations 

• Allow other presenters to share control of applications that are running on your computer 

• Work together on Live Meeting collaborative slides (for example, add Annotations) 

IMPORTING CONTENT 

If you want to display content created outside of Live Meeting (that is, not a collaborative slide) you must first import the 
content as a resource in the Live Meeting console. Importing is most commonly used to add slide presentations. 

NOTE: Resources that you import stay in the meeting until you remove them. If you import content during a Meet Now meeting that 
you have organized, the content will remain there for all of your future Meet Now meetings until you remove it. 

As you present content, you can change your display to Full Screen view to make the presentation larger and easier for 
attendees to see. 

To import content into the Live Meeting console: 

1. In the Share menu, click Share Document to View. 

2. Navigate to the file you want to import, and then click Open. The file is copied to the Live Meeting service and 
added to the Resources pane in the Live Meeting console. 
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To change your display from Console view to Full Screen view: 

1. In the View menu, click Full Screen Mode. 

2. To return to Console view, press ESC. 

SHARING CONTENT 

Use these scenarios to get started quickly with some common methods of sharing Live Meeting content. 

To present slides: 

NOTE: This scenario assumes that you have created a PowerPoint slide presentation that you want to present in the meeting. 

1. In the Share menu, click Share Document to View. 

2. Navigate to the presentation you want to display, and then click Open. The file is copied to the Live Meeting 
service and added to the Resources pane in the meeting console. You can now present the slides. 

To collaborate on a Word document: 

NOTE: This scenario assumes that you want to share a Word document with other attendees in a meeting and show them the changes 
you are making to the document as your discussion progresses. 

1. In the Share menu, click Share Document to Edit. 

WWW.INTERCALL .COM       1-877-812-4520
t

AAP/EOE 
Last Rev. 2.16.06 

Microsoft and he Microsoft Office Logo are either trademarks 
or registered trademarks of Microsoft Corporation in the United 
States and/or other countries. 



G
LO

B
A

L C
O

N
F

E
R

E
N

C
IN

G
 S

O
LU

T
IO

N
S

 
 
 
 

 

2. Navigate to the Word file you want to display and click Open. 

The file appears on your desktop with the sharing controls along the left side of your screen and is visible to all 
attendees. You can now make changes to the document and others will see the changes in real time. 

To lead a group review of a read-only file: 

NOTE: This scenario assumes that you will share a file (other than slides) that you want all attendees to see but you will not 
collaborate on making changes—although you can use annotations to mark up the file. 

1. In the Share menu, click Share Document to View. 

2. Navigate to the file you want to display and click Open. The file is copied to the Live Meeting service and added 
to the Resources pane in the Live Meeting console. You can now discuss the file and attendees can make 
annotations on it (if permitted). 
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To lead a brainstorming session using a Whiteboard slide: 

NOTE: This scenario assumes that you and the other attendees will draw/write together on a Whiteboard slide in order to brainstorm 
your ideas for a project. 

In the Share menu, click Whiteboard. Meeting attendees can draw or type on the slide using the annotation tools. 

NAVIGATING CONTENT 

You and other presenters manage Live Meeting content using the Resources pane in the meeting console. The Resources 
pane displays all of the content that you and the other presenters have made available for sharing during the meeting. 
To share content, you must first add the content to the Resources pane either by importing it or by creating a new Live 
Meeting collaborative slide. 

After you have added content to the Resources pane, you can click the resource in the Resource pane to display it. If a 
resource contains multiple parts (for example, a slide presentation) you can view the parts by clicking the resource and 
viewing the Thumbnails pane. Within the thumbnails pane, you can right-click any thumbnail image to perform the 
following actions: 

• Insert a collaborative slide before the thumbnail image 

• Perform PowerPoint functions (if the resource is a presentation) 

To view the Resources pane: 

In the View menu, point to Panes and click Resources. 
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To view the Thumbnail pane for a resource: 

1. In the Resources pane, click the resource whose thumbnails you want to view. 

2. In the View menu, click Show Thumbnails. 

 

SHARING THE  USE  OF  YOUR COMPUTER  

In addition to uploading content, you can share the use of your computer during a Live Meeting session. 

Sharing the use of your computer can take several forms. The simplest way to share is to open a document on your 
computer and make changes to the file while displaying it to the other attendees. Or, if you want to show multiple 
processes on your computer involving more than one application, you can share your entire desktop. 

For either of these options, you can also share control (over the application or over the desktop) with other participants 
in the meeting. While you are sharing control, the other participant has access to all of the same abilities that you have 
on your computer. At any point, you can end application sharing control and the other participant’s ability to control 
your computer is blocked. 

To open and display a file from your computer: 

1. In the Share menu, click Share Document to Edit. 

2. Navigate to the file you want to display and click Open. The file appears on your desktop with the sharing 
controls along the left side of your screen and is visible to all attendees. 

To display an application that is installed on your computer: 

1. Start the application that you want to display to attendees. 

2. In the Share menu, click Share Application. 

3. In the Sharing dialog box, click the name of the application you want to display. 

4. Click OK. The application you shared is now visible to all attendees. The sharing controls will be visible to you 
only along the left side of your screen. 

To display the sharing frame: 

1. In the Share menu, click Share Application. 

2. In the Sharing dialog box, click The Sharing Frame. 

3. Click OK. The Sharing Frame appears on your desktop. 

4. Resize the Sharing Frame as needed for the contents of your desktop that you want to display to attendees. The 
portion of your desktop inside the Sharing Frame is now visible to all attendees. The sharing controls will be visible 
to you only along the left side of your screen. 
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To display your desktop: 

1. In the Share menu, click Share Application. 

2. In the Sharing dialog box, click Desktop. 

3. Click OK. Your desktop is now visible to all attendees. The sharing controls will be visible to all participants along 
the left side of your screen. 

4. Optional: To hide the sharing controls from meeting participants, click the Sharing Options button, select the 
Display tab and mark the checkbox next to Auto-Hide the sidebar. 

To share control of your computer with another presenter: 

1. In the Sharing controls, click the Share Control button. 

2. In the Give Control dialog box, click the name of attendee to whom you want to give control then click OK. That 
participant can now use the selected items on your computer. For example, if you give control of Microsoft Word, 
the selected participant will be controlling the Word document that resides on your computer and all other 
participants will be able to see his/her actions. 

To end application sharing control: 

On the Sharing controls, click the Take Control button. 

 

US ING COLLABORAT IVE  SL IDES  

Collaborative slides are Live Meeting slides that help you collaborate with other attendees. Unlike PowerPoint 
presentations, collaborative slides do not need to be imported or created in advance. You can insert collaborative 
slides on-the-fly during a meeting. 

The following five collaborative slide types are available: 

• Whiteboard slide - A Whiteboard slide is a blank image slide upon which you can draw, add text and stamps, 
and highlight information by using the Annotation tools. For example, if you want to quickly create a flow chart to 
illustrate a point, insert a Whiteboard slide then use the Annotation tools to draw squares, lines, etc. 

• Web slide - A Web slide lets you display a web page to the attendees and provides each attendee with an 
independent connection to that URL, allowing them to navigate the site freely. Web slides are ideal for allowing 
attendees to complete a survey or form during your meeting. Web slides are also great for incorporating video or 
flash files into your meeting. 

NOTE: If you want to show participants a website, but need to control the navigation of it, share your web browser using the 
Share Application option as discussed in the previous section. 

• Text slide - A Text slide is a blank editable slide upon which you can type. For example, if you want to type new 
information that is available to the audience to copy and paste, such as an action items list, you can create a Text 
slide. When you work with a Text slide, you can use the Edit menu commands to copy, paste, cut and delete text. 
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• Polling slide - Use Polling slides to find out attendees’ reactions and opinions during a presentation. Polling 
slides are a great way to solicit feedback from attendees by allowing them to select from several responses to a 
question. You can create Polling slides ahead of time or insert them on-the-fly during your presentation. 

• Snapshot slide - A Snapshot slide shows a captured screen shot from your computer, such as a captured 
spreadsheet or graphic. After you create a Snapshot, you can use the Annotation tools to add annotations to it. 

Typically, you will add collaborative slides as new resources. However, you may choose to insert a collaborative slide 
into an existing resource—for example, as a new slide in a PowerPoint presentation resource that you previously 
imported. 

To add a collaborative slide as a new resource: 

In the Share menu, click the type of slide you want to add: Whiteboard, Web, Text, Polling or Snapshot.

The slide is added as a new resource in the Resources pane and you can begin using it to collaborate with other 
attendees. 

To insert a collaborative slide into an existing resource: 

1. In the Resources pane, click the resource into which you want to add a collaborative slide. 

2. In the Thumbnails pane, right-click the thumbnail directly above the point where you want to insert the slide. Point 
to Insert New Slide then click the type of slide you want to add: Whiteboard, Web, Text, Polling or 
Snapshot. The slide is added at the insertion point you specified in the existing resource. 
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